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Abstract: Proteins do not function
in isolation; it is their interactions
with one another and also with
other molecules (e.g. DNA, RNA)
that mediate metabolic and signal-
ing pathways, cellular processes,
and organismal systems. Due to
their central role in biological
function, protein interactions also
control the mechanisms leading to
healthy and diseased states in
organisms. Diseases are often
caused by mutations affecting the
binding interface or leading to
biochemically dysfunctional alloste-
ric changes in proteins. Therefore,
protein interaction networks can
elucidate the molecular basis of
disease, which in turn can inform
methods for prevention, diagnosis,
and treatment. In this chapter, we
will describe the computational
approaches to predict and map
networks of protein interactions
and briefly review the experimental
methods to detect protein interac-
tions. We will describe the applica-
tion of protein interaction networks
as a translational approach to the
study of human disease and eval-
uate the challenges faced by these
approaches.

This article i3 part of the “Transla-
tional Bioinformatics™ collection for
PLOS Computational Buology.

1. Introduction

Early biological experiments revealed
proteins as the main agents of biological
function. As such, proteins ultimately
determine the phenotype of all organ-
isms. Since the advent of molecular
biology we have learned that proteins
do not function in isolation; instead, it is
their interactions with one another and
also with other molecules (e.g. DNA,
RNA) that mediate metabolic and signal-
ing pathways, cellular processes, and
organismal systems.

The concept of “protein interaction” is
generally used to describe the physical
contact between proteins and their interact-
ing partners. Proteins associate physically to

PLOS Computational Biology | www.ploscompbiol.org 1

create macromolecular structures of various
complexities and heterogeneities. Proteins
Interact in pairs to form dimers (e.g. reverse
transcriptase), multi-protein complexes (e.g.
the proteasome for molecular degradation),
or long chains (e.g. actin filaments in muscle
fibers). The subunits creating the various
complexes can be identical or heteroge-
neous (e.g. homodimers vs. heterodimers)
and the duration of the interaction can be
transient (e.g. proteins involved in signal
transduction) or permanent (e.g. some
ribosomal proteins). However, protein in-
teractions do not always have to be physical
[1]. The term “protein interaction” is also
used to describe metabolic or genetic
correlations, and even co-localizations.
Metabolic interactions describe proteins
mvolved in the same pathway (e.g. the
Krebs cycle proteins), while genetically
identified associations identify co-expressed
or co-regulated proteins (e.g. enzymes
regulating the glycolytic pathway). As the
name implies, protein interactions by co-
localization list proteins found in the same
cellular compartment.

Whether the association is physical or
functional, protein-protein interaction
(PPI) data can be used in a larger scale
to map networks of interactions [2,3]. In
PPI network graphs, the nodes represent
the proteins and the lines connecting them
represent the interactions between them
(Figure 1). Protein interaction networks
are useful resources in the abstraction of
basic science knowledge and in the
development of biomedical applications.
By studying protein interaction networks
we can learn about the evolution of
individual proteins and about the different
systems in which they are involved.

Likewise, interaction maps obtained from
one species can be used, with some
limitations, to predict interaction networks
in other species. Protein interaction net-
works can also suggest functions for
previously uncharacterized proteins by
uncovering their role in pathways or
protein complexes [4]. Due to their central
role in biological function, protein inter-
actions also control the mechanisms lead-
ing to healthy and diseased states in
organisms. Diseases are often caused by
mutations affecting the binding interface
or leading to biochemically dysfunctional
allosteric changes in proteins. Therefore,
protein interaction networks can elucidate
the molecular basis of disease, which in
turn can inform methods for prevention,
diagnosis, and treatment [5,6].

The study of human disease experi-
enced extensive advancements once the
biomedical characterization of proteins
shifted to studies taking into account a
protein’s network at different functional
levels (i.e. in pair-wise interactions, in
complexes, in pathways, and in whole
genomes). For instance, consider how our
understanding of Huntington’s disease
(HD) has evolved from the early Mende-
lian single-gene studies to the latest HD-
specific network-based analyses. HD is an
autosomal dominant neurodegenerative
disease with features recognized by Hun-
tington in 1872 [7], and whose specific
patterns of inheritance were documented
in 1908 [8]. After almost a century of
genetics studies, the culprit gene in HD
was identified; in 1993, we learned that
HD was caused by the repeat expansion of
a CAG trinucleotide in the Huntingtin (Ht)
gene [9]. This expansion causes aggrega-
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tion of the mutant / in insoluble neuronal
inclusion bodies, which consequently leads
to neuronal degeneration. Yet, even when
the key disease-causing protein in HD had
been identified, the mechanism for Hi
aggregation remained unknown. In 2004,
Goehler et al. [10] mapped all the PPIs that
take place in HD and discovered that the
interaction between Hitt and GITI1, a
GTPase-activating protein, mediates Hit
aggregation. Further validation ([11,12])
confirmed GTII’s potential as a target for
therapeutic strategies against HD.

In this chapter, we will describe the main
experimental methods to identify protein
interactions and the computational ap-
proaches to map their networks and to
predict new interactions purely i silico. We
will describe the application of protein
interaction networks as a translational ap-
proach to the study of human disease and
evaluate the challenges faced by these
approaches.

2. Experimental Identification
of PPIs
2.1 Biophysical Methods

Protein  interactions are identified
through different biochemical, physical,
and genetic methods (Figure 2). Historical-
ly, the main source of knowledge about
protein interactions has come from bio-
physical methods, particularly from those
based on structural information (e.g. X-ray
crystallography, NMR spectroscopy, fluorescence,
atomic force microscopy). Biophysical methods
identify interacting partners and also pro-
vide detailed information about the bio-
chemical features of the interactions (e.g.
binding mechanism, allosteric changes
mvolved). Yet, since they are time- and
resource-consuming, biophysical character-
izations only permit the study of a few
complexes at a time.

2.2 High-Throughput Methods

To document protein interactions at a
larger scale, automated methods have been
developed to detect interactions directly or
to deduce them through indirect approach-
es (Figure 2).

2.2.1 Direct high-throughput
methods. Yeast two-hybrid (Y2H) is one
of the most-commonly used direct high-
throughput method. The Y2H system tests

PLOS Computational Biology | www.ploscompbiol.org 2

Experimental and computational methods to detect protein interactions
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the interaction of two given proteins by
fusing each of them to a transcription-
binding domain. If the proteins interact,
the transcription complex is activated,
which transcribes a reporter gene whose
product can be detected. Since it is an
vivo technique, the Y2H system is highly
effective at detecting transient interactions
and can be readily applied to screen large
genome-wide libraries (e.g. to map an
organisms’ full set of interactions or
interactome). But, the Y2H system is
limited by its biases toward non-specific
interactions.  Likewise, Y2H cannot
identify complexes (i.e. it only reports
binary interactions) or interactions of pro-
teins initiating transcription by themselves.
Although protein interactions are usually
detected and studied in pair-wise form, in
reality they often occur in complexes and
as part of larger networks of interaction. In
vitro direct detection methods (e.g. mass
spectrometry, affinity purification) are better
suited to detect macromolecular inte-
ractions, yet, they have their own
limitations: Interactions occurring & vitro
do not necessarily occur m vivo (e.g. when
proteins are  compartmentalized in
different cell locations) and complexes
are often difficult to purify, which is a
required step in the protocol [13].

2.2.2 Indirect high-throughput
methods. Several high-throughput
methods deduce protein interactions by
looking at characteristics of the genes enco-
ding the putative mteracting partners. For
mstance, gene co-expression is based on the
assumption that the genes of interacting pro-
teins must be co-expressed to provide the
products for protein interaction. Expression
profile similarity is calculated as a correla-
tion coefficient between relative expression
levels and subsequently compared against a
background distribution for random non-
interacting proteins. Synthetic lethality, on the
other hand, introduces mutations on two
separate genes, which are viable alone but
lethal when combined, as a way to deduce
physically interacting proteins [14].

3. Computational Predictions of
PPIs

As discussed in section 2, experimental
approaches provide the means to either

empirically characterize protein interac-
tions at a small scale or to detect them at a
large scale. Still, experimental detections
only generate pair-wise Interaction rela-
tionships and with incomplete coverage
(because of experimental biases toward
certain protein types and cellular localiza-
tions). Experimental identification meth-
ods also exhibit an unacceptably high
fraction of false positive interactions and
often show low agreement when generated
by different techniques [15-17]. Experi-
mental biophysical methods can comple-
ment the high-throughput detections by
providing specific interaction details; but
they are expensive, extremely laborious,
and can only be implemented for a few
complexes at a time.

Computational methods for the predic-
tion of PPIs provide a fast and inexpensive
alternative to complement experimental
efforts. Computational interaction studies
can be used to validate experimental data
and to help select potential targets for
further experimental screening [18]. More
importantly, computational methods give
us the ability to study proteins within the
context of their interaction networks at
different functional levels (i.e. at the
complex, pathway, cell, or organismal
level), thus, allowing us to convert lists of
pair-wise relationships into complete net-
work maps. Since they are based on
different principles, computational tech-
niques can also uncover functional rela-
tionships and even provide information
about interaction details (e.g. domain
interactions), which may elude some
experimental methods.

3.1 Computational Methods for PPI
Predictions

Computational interaction prediction
methods can be classified into two types:
methods predicting protein domain inter-
actions from existing empirical data about
protein-protein interactions and methods
relying entirely on theoretical information
to predict protein-protein or domain-
domain interactions (Figure 2).

3.1.1 Empirical predictions. The
computational techniques based on experi-
mental data use the relative frequency of
nteracting domains [19], maximum likelihood esti-
mation of domain interaction probability [20,21],
co-expression [22], or network properties [23-27]
to predict protein and domain interactions.
The main disadvantage of empirical com-
putations is that, by relying on an existing
protein network to infer new nodes, they
propagate the inaccuracies of the experi-
mental methods.

3.1.2 Theoretical predictions.
Theoretical techniques to predict PPIs
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Figure 1. A PPI network of the proteins encoded by radiation-sensitive genes in mouse, rat, and human, reproduced from [89].
Yellow nodes represent the proteins and blue lines show the interactions between them. The radiation-related genes were text-mined from PubMed
and the protein interaction information was obtained from HPRD.

doi:10.1371/journal.pcbi.1002819.g001
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Figure 2. A diagram of the different experimental and computational methods to characterize, detect, and predict PPIs.

doi:10.1371/journal.pcbi.1002819.g002

incorporate a variety of biological
considerations; they take advantage of
the fact that interacting proteins coevolve
to preserve their function (e.g. murrortree,
phylogenetic profiling [28-35]), occur in the
same organisms (e.g. [36,37]), conserve
gene order (e.g. gene neighbors method
[38,39]) or are fused in some organisms
(e.g. the Rosetta Stone method [40,41]).

3.2 Theoretical Predictions of PPls

Based on Coevolution

Below, we will expand on two methods
generating theoretical PPI predictions
through coevolutionary signal detection
either at the residue or at the full-sequence
level.

3.2.1 Coevolution at the residue
level. Pairs of residues within the same
protein can coevolve because of three-
dimensional proximity or shared function
[42]. The intramolecular correlations of
interacting protein partners can be used to
predict  intermolecular  coevolution.
Residue-based ~ coevolution — methods
measure the set of correlated pair
mutations in each protein. A pair of
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proteins is assumed to interact if they
show enrichment of the same correlated
mutations [42].

3.2.2 Coevolution at the full-
sequence Methods  detecting
coevolution at the full-sequence level are
based on the idea that changes in one
protein are compensated by correlated
changes in its interacting partner to
preserve the interaction [29,30,42-45].
Therefore, as interacting proteins
coevolve, they tend to have phylogenetic
trees with topologies that are more similar
than expected by chance [46]. The
coevolution of interacting proteins was
first qualitatively observed for polypeptide
growth factors, neurotransmitters, and
system proteins with their
respective  receptors  [47].  Several
methodologies have been developed to
measure coevolution at the full-sequence
level, and among them, the mirrortree
method is one of the most intuitive and

level.

immune

accurate options. As shown in Figure 3,
mirrortree  measures coevolution for a
given pair of proteins by i) identifying the
orthologs of both proteins in common
species, 1) creating a multiple sequence

alignment (MSA) of each protein and its
orthologs, iii) from the MSAs, building
distance matrices, and iv) calculating the
correlation  coefficient  between  the
distance  matrices. The  mirrortree
correlation  coefficient is used for
measuring  tree  similarity, thereby,
allowing the evaluation of whether the
proteins in question coevolved [28—
35].

The mirrortree method has been suc-
cessfully implemented to confirm experi-
mental interactions in F. coli [4], S.
cerevisiae (48], and H. sapiens [49]. But,
the degree of similarity between the
phylogenetic trees is strongly affected by
the sequence divergence driven by the
underlying speciation process [4,50].
Therefore, two proteins may have similar
phylogenetic trees due only to common
speciation events, but they may not
necessarily be interacting partners. By
subtracting the signal from speciation
events Pazos et al. [4] and Sato et al.
[50] showed improvements for the per-
formance of the mirrortree method. One
approach creates a ‘“speciation” vector
from the distance matrices derived from
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doi:10.1371/journal.pcbi.1002819.g003

the ribosomal 16S sequences (for prokary-
otes and 18S for eukaryotes), while the
other uses the average distance of all
proteins in a pair of organisms. Both
methods subtract the speciation vector
from the original distance matrix con-
structed for the given protein pair.

In principle, to characterize protein
interactions at a systems level, all pro-
tein-protein and domain-domain interac-
tions in a given organism must be
catalogued. The mirrortree method is a
suitable option to complement experimen-
tal detections because it is inexpensive and
fast. Moreover, mirrortree only requires
the proteins’ sequences as input and thus
can be used to analyze proteins for which
no other information is available. Since
mirrortree predictions are based on differ-
ent principles than any other computa-
tional or experimental techniques, they
can also uncover functional relationships
eluding other methods. Still, the imple-
mentation of the mirrortree approach is
under several limitations. One limitation
of the mirrortree method is the minimum
number of orthologs it requires. Selecting
orthologs in large families with many
paralogs is also a considerable challenge
for mirrortree [49]. In addition, coevolu-
tion does not necessarily take place
uniformly across the sequence; different
sites may coevolve at different rates based
on functional constraints. Thus, coevolu-
tion signals vary when measured across the
entire sequence vs. at the domain level

[51].
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4. Protein Networks and
Disease

4.1 Studying the Genetic Basis of
Disease

The majority of our current knowledge
about the ectiology of various diseases
comes from approaches aiming to uncover
their genetic basis. In the near future, the
ability to generate individual genome data
using next generation sequencing methods
promises to change the field of transla-
tional bioinformatics even more.

Since the inception of Mendelian ge-
netics in the 1900’s, great effort has gone
into cataloguing the genes associated with
individual diseases. A gene can be isolated
based on its position in the chromosome
by a process known as positional cloning
[52]. A few examples of human disease-
related genes identified by positional
cloning include the genes associated with
cystic fibrosis [53], HD [9], and breast
cancer susceptibility [54,55]. Even in
simple Mendelian diseases, however, the
correlation between the mutations in the
patient’s genome and the symptoms is not
often clear [56]. Several reasons have been
suggested for this apparent lack of corre-
lation between genotype and phenotype,
including pleiotropy, influence of other
genes, and environmental factors.

Pleiotropy occurs when a single gene
produces multiple phenotypes. Pleiotropy
complicates disease elucidation because a
mutation on a pleiotropic gene may have
an effect on some, all, or none of its traits.

Therefore, mutations in a single gene may
cause multiple syndromes or only cause
disease in some of the biological processes
the gene mediates. Establishing which geno-
types are responsible for the perturbed
phenotype of interest is not straightforward.

Genes can influence one another in several
ways; genes can interact synergistically,
(as in epistasis), or they can modify one
another (e.g. the expression of one gene
might affect the expression of another).
Cystic fibrosis and Becker muscular
dystrophy, previously considered classical
examples of Mendelian patterns of inher-
itance, are now believed to be caused by
a mutation of one gene which is modified
by other genes [57,58]. Thus, even simple
Mendelian diseases can lead to complex
genotype-phenotype associations [39].

Environmental factors (e.g. diet, infection
by bacteria) are also major determinants of
disease phenotype expression often acting
in combination with other genotype-phe-
notype association confounders (i.e. plei-
otropy and gene modifiers). In fact, most
common diseases such as cancer, meta-
bolic, psychiatric and cardio-vascular dis-
orders (e.g. diabetes, schizophrenia and
hypertension) are believed to be caused by
several genes (multigenic) and are affected
by several environmental factors [60].

4.2 Studying the Molecular Basis of
Disease

Much can be learned from document-
ing the genes associated with a particular
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disease (c.g. identifying risk factors that
might be used for diagnostic purposes).
Yet, to understand the biological details of
pathogenesis and disease progression and
to subsequently develop methods for
prevention, treatment and even diagnosis,
it is necessary to identify the molecules and
the mechanisms triggering, participating,
and controlling the perturbed biological
process. Deciphering the molecular mech-
anisms leading to diseased states is an even
bigger challenge than elucidating the
genetic basis of complex diseases [61].
Even when the genetic basis of a disease is
well understood, not much is known about
the molecular details leading to the
disorders.

4.2.1 The role of protein
interactions  in Protein
interactions provide a vast source of
molecular information; their interactions
(with one another, DNA, RNA, or small
molecules) are involved in metabolic,
signaling, immune, and gene-regulatory
networks.  Since protein interactions
mediate the healthy states 1 all
biological processes, it follows that they
should be the key targets of the molecular-
based studies of biological diseased states.
Disease-causing ~ mutations  affecting
protein  interactions can lead to
disruptions in protein-DNA interactions,
protein  misfolds, new  undesired
Interactions, or can enable pathogen-host
protein interactions.

Protein-DNA wnteraction disruptions are most
clearly illustrated by the p53 tumor
suppressor protein and its role in cancer.
Mutations on p53’s DNA-binding domain
destroy its ability to bind to its target DNA
sequences, thus preventing transcriptional
activation of several anti-cancer mecha-
nisms it mediates (e.g. apoptosis, genetic
stability, and inhibition of angiogenesis).

disease.

Protein musfolding can result in disruptions
of protein-protein interactions, as occurs
in the Von Hippel-Lindau syndrome
(VHL)—VHL is a rare condition in which
hemangioblastomas are formed in the
cerebellum, spinal cord, kidney, and
retina. A mutation from Tyrosine to
Histidine at residue 98 on the binding site
disrupts binding of the VHL protein to the
hypoxia-inducible factor (HIF) protein. As
a result, the VHL protein no longer
degrades the HIF protein, which leads to
the expression of angiogenic growth fac-
tors and local proliferation of blood vessels
[62,63].

New undesired protein interactions are the
main causes of several diseases, including
Huntington’s disease (see introduction),
cystic fibrosis, and Alzheimer’s disease.
New interactions alter homeostasis since
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they can lead to the loss of vital cellular
functions (due to misfolding and aggrega-
tion) and can cause cytotoxicity [11].

Pathogen-host protein interactions also play a
key role in bacterial and viral infections by
facilitating the hijacking of the host’s
metabolism for microbial need. The inter-
action between the Human papillomavirus
(HPV) and its host provides one of the
most striking examples of the centrality of
protein interactions in infectious diseases.
HPYV infection occurs in a large fraction of
the population (75-80% of Americans
[64]) by generating lesions of the anogen-
ital tract and for some it leads to cancer.
Upon infection, the HPV genome is
frequently integrated into the host ge-
nome, but only two viral genes (E6 and
E7) are retained and expressed. Remark-
ably, the interactions of only two viral
proteins with the host’s proteins are
enough to cause HPV-induced carcino-
genesis. E6 and E7 bypass the immune
system by interacting with important
negative cell regulatory proteins to target
them for degradation and thus, inactiva-
tion. These two proteins also inhibit
cellular terminal differentiation, induce
cellular transformation and immortaliza-
tion of the host cells, and direct the
proliferation of the tumorigenically-trans-
formed cells [65].

4.2.2 Using PPI networks to
understand disease. PPl networks can
help identify novel pathways to gain basic
knowledge of disease. Note that pathways
are different from PPI networks. PPI
networks map the physical or functional
interaction between protein pairs resulting
in a complex grid of connections (Figure 1).
Pathways, on the other hand, represent
genetic, metabolic, signaling, or neural
processes as a series of sequential
biochemical reactions where substrates
are changed in a linear fashion. For
instance, the glycolysis pathway maps the
conversion of glucose to pyruvate through
a linear chain of ten different steps.

Pathway analysis alone cannot uncover
the molecular basis of disease. When
performing pathway analysis to study
disease, differential expression experi-
ments are the main source of protein
candidates. However, most of the gene
expression candidates are useless to path-
way-based analysis of disease because the
majority of human genes have not been
assigned to a pathway. Protein interaction
networks can be used to identify novel
pathways. Protein interaction subnetworks
tend to group together the proteins that
interact in functional complexes and
pathways [66]. Thus, new methods are
being developed to accurately extract

interaction subnetworks to yield pathway
hypotheses that can be used to understand
different aspects of disease progression
[67,68]. See Table 1 for useful resources
incorporating pathway and PPI informa-
tion in disease elucidation.

Mapping interactomes provide the op-
portunity to identify disease pathways by
identifying key subnetworks. In 2005, Rual
et al. [69] mapped the human protein
interactome. Below are some of the
findings that have been uncovered when
combining PPI and pathway analysis since
then.

(i) Over 39,000 protein interactions
have been identified in the human
cell [70].

(i1) Disease genes are generally non-

essential and occupy peripheral
positions in the human interac-
tome [71], although, in a few
diseases like cancer, disease genes
tend to encode highly-connected
proteins (hubs) [72,73].

(i)  Disease genes tend to cluster to-
gether and co-occur in central
network locations [6].

(iv) Proteins involved in similar pheno-
types (e.g. all cancer proteins) are
highly interconnected [73].

v) Viral networks differ significantly
from cellular networks, which rais-
es the hypothesis that other intra-
cellular pathogens might also have
distinguishing topologies [74].

(vi) Etiologically unrelated diseases of-
ten present similar symptoms be-
cause separate biological processes
often use common molecular path-

ways [73].

PPI networks can be used to explore the
differences between healthy and diseased
states. Building interaction networks for
systems under different conditions (e.g.
wild type vs. mutant, presence of environ-
mental factor vs. its absence) might be the
key to understanding the differences
between healthy and pathological states.
The work by Charlesworth e al. [76] on
the perturbation of the canonical path-
ways and networks of interactions when
humans are exposed to cigarette smoke
illustrates the potential of such approach-
es. As one might expect, this study found
that the smoking-susceptible genes were
overrepresented in pathways involved in
several aspects of cell death (cell cytotox-
icity, cell lysis), cancer (e.g. tumorigenesis),
and respiratory functions. A somewhat
more unexpected finding, however, con-
firmed that exposure to the smoke envi-
ronmental factor affected a large subnet-
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Table 1. Pathway databases with disease information.

Resource Featured organisms Disease information Website

KEGG Yeast, mouse, human Comprehensive http://www.genome.jp/kegg/disease/
REACTOME Human+20 other species Sparse http://reactome.org/

SMPDB Human Small molecules’ Metabolic disease pathways http://www.smpdb.ca

PharmGKB Human Gene-drug-disease relationships http://www.pharmgkb.org/index.jsp
NetPath Human 10 immune and 10 cancer pathways http://www.netpath.org/index.html

doi:10.1371/journal.pcbi.1002819.t001

work of proteins involved in the immune-
inflammatory response. This study gave
new insights into how smoke causes
disease: the exogenous toxicants in smoke
perturb several protein interactions in the
healthy cell state, thereby depressing the
system, while disrupting the
inflammation response. The study also
explained why smoking cessation has some
immediate health benefits; eliminating
smoke exposure reverses the alterations
at the transcriptomic level and restores the
majority of normal protein interactions.
Protein interaction studies play a major role in
the prediction of genotype-phenotype associations
while also identifying new disease genes.
The identification of disease-associated
interacting proteins also identifies poten-
tially interesting disease-associated gene
candidates (i.e. the genes coding for the
interacting proteins are putative disease-
causing genes). One of the best ways to
identify novel disease genes is to study the
interaction partners of known disease-
associated proteins [77]. Gandhi et al.
[78] found that mutations on the genes
of interacting proteins lead to similar
disease phenotypes, presumably because
of their functional relationship. Therefore,
protein interactions can be used to prior-
itize gene candidates in studies investigat-
ing the genetic basis of disease [79].
Others have used the properties of protein
interaction networks to differentiate dis-
case from non-disease proteins. Based on
this approach, Xu et al. [80] devised a
classifier based on several topological
features of the human interactome to
predict genes related to disease. The
classifier was trained on a set of non-
disease and a set of disease genes (from
OMIM) and applied to a collection of over
5,000 human genes. As a result, 970
disease genes were identified, a fraction
of which were experimentally validated.
New diagnostic tools can result from genotype-
phenotype  associations established through
PPIs. The genes of interacting proteins
can be studied to identify the mutation(s)
leading to the interaction disruptions seen
in healthy individuals or to the creation of

Immune
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new interactions only present in the
diseased states. For example, Rossin e al.
used genome-wide association studies
(GWAS) to identify regions with variations
that predispose immune-mediated diseases
[81]. The GWAS studies provided a list of
proteins found to interact in a preferential
manner. The resulting disease single-
nucleotide polymorphisms identified by
GWAS studies such as that by Rossin e
al. can be eventually incorporated into
genotyping diagnostic tools.

Identifying disease subnetworks, and in tumn
pathways that get activated in diseased states, can
provide markers to create new prognostic
tools. For instance, using a protein-net-
work-based approach, Chuang e al. [66]
identified a set of subnetwork markers that
accurately classify metastatic vs. non-
metastatic tumors in individual patients.
Metastasis 1s the leading cause of death in
patients with breast cancer. However, a
patient’s risk for metastasis cannot be
accurately predicted and it is currently
only estimated based on other risk factors.
When metastasis is deemed likely, breast
cancer patients are prescribed aggressive
chemotherapy, even when it might be
unnecessary. By integrating protein net-
works with cancer expression profiles, the
authors identified relevant pathways that
become activated during tumor progres-
sion, which discriminate metastasis better
than markers previously suggested by
studies using differential gene expression
alone.

Disease networks can inform drug design by
helping suggesting key nodes as potential
drug targets. Drug target identification
constitutes a good example of the potential
of integrating structural data with high-
throughput data [82]. The structural
details on binding or allosteric sites can
be used to design molecules to affect
protein function. On the other hand,
reconstruction of the different protein
networks (signaling, metabolic, regulatory,
etc.) in which the potential target is
involved can help predict the overall
impact of the disruption. If, for example,
the target is a hub (a highly connected

protein), its inhibition may affect many
activities that are essential for the proper
function of the cell and might thus be
unsuitable as a drug target. On the other
hand, less connected nodes (e.g. nodes
affecting a single disease pathway) could
constitute vulnerable points of the disease-
related network, which are better candi-
dates for drug targets. The work by
Yildirim and Goh [83] illustrates the
advantages of evaluating drugs within the
context of cellular and disease networks.
This group created a drug-target network
to map the relationships between the
protein targets of all drugs and all
disease-gene products. The topological
analysis of the human drug-target network
revealed that (i) most drugs target currently
known targets; (ii) only a small fraction of
disease genes encodes drug-target proteins;
(iti) current drugs do not target diseases
equally but only address some regions of
the human disease network; and (iv) most
drugs are palliative—they treat the symp-
toms not the cause of the disease, which
largely reflects our lack of knowledge
regarding the molecular basis of diseases
such that for many pathologies we can only
treat the symptoms but not cure them.

5. Summary—Trends in the
Translational Characterization
of Human Disease

We are still quite far from understand-
ing the etiology of most diseases. Further
advances on relevant experimental tech-
nology (e.g. genetic linkage, protein inter-
action prediction), along with integrative
computational tools to organize, visualize,
and test hypotheses should provide a step
forward in that direction. More than ten
years after the completion of the human
genome project, it is clear that our
approach to human disease elucidation
needs to change. The $3-billion human
“book of life” and the $138-million effort
to catalog the common gene variants
relevant to disease have so far failed to
deliver the wealth of biological knowledge
of human diseases and the subsequent
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personalization of medicine the scientific
community expected [84].

To date, biomedical research of the
etiology of disease has largely focused on
identifying disease-associated genes. But,
the molecular mechanisms of pathogenesis
are extremely complex; gene-products
interact in different pathways and multiple
genes and environmental factors can affect
their expression and activity. Likewise, the
same proteins may participate in different
pathways and mutations on their genes
may or may not affect some or all of the
biological processes they mediate. Thus,
gene-disease  associations cannot be
straightforwardly deduced and their use-
fulness alone (in the absence of a molec-
ular context) in elucidating the biology of
healthy phenotype disruptions is question-
able. Evidence is accumulating to suggest
that in the majority of cases illnesses are
traceable to a large number of genes
affecting a network or pathway. The
effects on healthy phenotype disruption
may vary from one individual to another
based on the person’s gene variants and on
how disruptive the alterations might be to
the network [85].

To achieve a comprehensive genotype-
phenotype understanding of disease, trans-
lational research should be conducted
within a framework integrating methodol-
ogies for uncovering the genetics with
those investigating the molecular mecha-
nisms of pathogenesis. In fact, the studies
yielding the most biological insight into
disease to which we alluded in this chapter
were those which implemented a com-
bined  genotype-phenotype  approach;
those studies identified the disease-suscep-
tible genes and investigated their network
of interactions and affected pathways. As a
result, the combined approaches managed
to explain known clinical observations
while also suggesting new mechanisms of
pathology.

PPI analysis provides an effective means
to investigate biological processes at the
molecular level. Yet, any conclusions
obtained based on PPI methods must be
validated since these methods are subject
to limitations inherent to the nature of
data collection and availability. First, one
must be aware that the roles of protein
interactions are context-specific (tissue,
disease stage, and response). Thus, two
proteins observed to interact m vitro might
not interact i vivo if they are localized in
different cell compartments. Even when in
common cell compartments, protein abun-
dance or presence of additional interactors
might affect whether the interaction oc-
curs at all. Second, most of the PPI
methodologies use a simplistic ‘static’ view

PLOS Computational Biology | www.ploscompbiol.org 8

of proteins and their networks. In reality,
proteins are continuously being synthe-
sized and degraded. The kinetics of
processes and network dynamics need to
be considered to achieve a complete
understanding of how the disruptions of
protein interactions lead to disease. Third,
human PPIs are often predicted based on
homology and from studies investigating
disease in other organisms. The same
mechanisms of interaction might or might
not exist in the organism of interest or
their regulation and phenotypic effects
might be different. Ideally, since network
and structural approaches are comple-
mentary, the combination of network
studies with a more detailed structural
analysis has the potential to enhance the
study of disease mechanisms and rational
drug design.

Currently, in the PPI field, a large
number of studies focus on the topological
characterization of organisms’ interac-
tomes. Those studies have yielded valuable
information regarding general trends of
molecular organization and their differ-
ences across genomes. To gain a deeper
understanding of individual diseases, how-
ever, the trend needs to move from global
characterizations to disease-specific inter-
actomes. Phenotype-specific interaction
network analyses should help identify
subnetworks mapping to pathways that
can be targeted therapeutically and point
to key molecules essential to the biological
function under study. Since disease infer-
ences are as good as the modeled PPI
networks, the ontologies used by PPI
resources need to be expanded to better
describe disease phenotypes, cytological
changes, and molecular mechanisms.

6. Exercises

Objective: To investigate Epstein-
Barr Virus (EBV) pathogenesis us-
ing protein-protein interactions

EBV is a member of the herpesvirus
family and one of the most common
human viruses. According to the CDC,
in the United States around 95% of adults
have been infected by EBV. Upon infec-
tion in adults, EBV replicates in epithelial
cells and establishes latency in B lympho-
cytes, eventually causing infectious mono-
nucleosis  35%-50% of the time and
sometimes cancer [86]. In the next four
sections, your goal will be to study the
interactions among EBV proteins and
between the virus and its host (using the
EBV-EBV and EBV-human interactomes
respectively) as a means to investigate how
EBV leads to disease at the molecular
level.

Datasets:
The following datasets were adapted
with permission from [87]

® Dataset S1: EBV interactome

o Dataset S2: EBV-Human interactome

Software requirements:

Download and install Cytoscape
(http://www.cytoscape.org, [88]) locally.

Note:

The instructions below correspond to
Cytoscape v. 2.8.0; but, should be appli-
cable to future releases.

I. Visualize the EBV interactome
using Cytoscape

A. Import Dataset S1 into cytos-
cape

® Select File ->Import ->Network (Multi-
ple File Types)

® (Click the “Select” button to browse to
Dataset S1’s location

®  Click “Import”

B. Change the network layout

Click on View->Hide data panel

Click the 1:1 magnmifying glass icon to
zoom out to display all elements of
the current network”

® Select Layout->Cytoscape Layouts-
> Force-directed (unweighted) Layout

C. Format the nodes and edges

Select View->Open Vizmapper
Choose the “Default” Current Visual Style

Click on the pair of connected nodes con in
the “Defaults™ box

® Scroll down on the resulting dialog to
change the following default visual
properties:

NODE__SIZE =20
NODE_FONT_SIZE =20

NODE_LABEL_POSI-
TION =(Node Anchor Points)
SOUTH

Note: Feel free to click and drag any
nodes with labels that overlap to
increase visual clarity.

D. Print the EBV interactome

® Sclect File->Export->Current Net-
work View as Graphics

Answer the following questions:

1. How many nodes and edges are
featured in this network?
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Table 2. Topological properties of human proteins for exercise lIl.

Average topological property ET-HP Random human protein
Degree 15%2 5.9+0.1

Number of components 12.6*0.25

Nodes in largest component 1,112 521=*5

Distance to other proteins 3.2+0.1 4.03+0.01

doi:10.1371/journal.pcbi.1002819.t002

ii.  How many self interactions does the
network have?

1. How many pairs are not connected
to the largest connected component?

iv.  Define the following topological pa-
rameters and explain how they might
be used to characterize a protein-
protein interaction network: node
degree (or average number of neigh-
bors), network heterogeneity, aver-
age clustering coeflicient distribu-
tion, network centrality.

II. Characterize the EBV-Human
interactome

Import Dataset S2 into cytoscape to
create a map of the EBV-Human inter-
actome. Format and output the network
according to steps A through D in part I.

Answer the following questions:

1. How many unique proteins were
found to interact in each organism?

ii.  How many interactions are mapped?

ii. How many human proteins are
targeted by multiple (i.e. how many
individual human proteins interact
with >1) EBV proteins?

iv. How does identifying the multi-
targeted human proteins help you
understand the pathogenicity of the
virus? —Hint: Speculate about the
role of the multi-targeted human
proteins in the virus life cycle.

v.  How might you test the predictions
you formulated above?

III. Characterize the topological
properties of the human proteins
that are targeted by EBV
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Use the topological information pro-
vided for you in Table 2 to investigate
whether the EBV-targeted Human Pro-
teins (E'T-HPs) differ from the average
human protein.

Answer the following questions:

1. Based on the ‘degree’ property, what
can you deduce about the connect-
edness of ET-HPs? What does this
tell you about the kind of proteins
(i.e. what type of network compo-
nent) EBV targets?

ii.  What do the number and size of the
largest components tell you about
the inter-connectedness of the ET-
HP subnetwork?

ii.  Why is distance relevant to network
centrality? What is unusual about the
distance of ET-HPs to other proteins
and what can you deduce about the
importance of these proteins in the
Human-Human interactome?

v. Based on your conclusions from
questions i-iii, explain why EBV
targets the ET-HP set over the other
human proteins and speculate on the
advantages to virus survival the
protein set might confer.

IV. Integrating knowledge from
three different interactomes
Answer the following questions:

1. The Rta protein is a transactivator
that is central to viral replication in
EBV. When Rta is co-expressed with
the LF2 protein replication attenuates
and the virus establishes latency.
Solely based on the EBV-EBV net-

work, formulate a hypothesis to
explain how LF2 may be driving
EBV to latency suggesting at least
one molecular mechanism by which
LF2 may inactivate Rta.

ii.  Why is establishing latency (opposed
to promoting rapid replication of
viral particles) an effective mecha-
nism of virus infection?

ii.  Assign putative functions to EBV’s
SM and EBNA3A proteins based on
the function of the human proteins
with which they interact—Hint: Lo-
cate these proteins in the EBV-
Human network. What clinical ob-
servation (see the introductory para-
graph to section 6. Exercises) might
these proteins’ subnetworks explain?

Answers to the Exercises can be found
in Text SI.

Supporting Information

Text S1 Answers to Exercises.

DOCX)

Dataset S1 EBV Interactome Data.
(SIF)

Dataset S2 EBV-Human Interactome
Data.

(SIF)

Figure S1 EBV Interactome Map.
(PDE)
Figure S2
Map.

(PDF)

EBV-Human Interactome
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Further Reading

e Chen JY, Youn E, Mooney SD (2009) Connecting protein interaction data, mutations, and disease using bioinformatics.

Methods Mol Biol 541: 449-461.

London: Springer.

Nussinov R, Schreiber G (2009) Computational protein-protein interactions. Boca Raton: CRC Press.

Ideker T, Sharan R (2008) Protein networks in disease. Genome Res 18: 644-652.

Juan D, Pazos F, Valencia A (2008) Co-evolution and co-adaptation in protein networks. FEBS Lett 582: 1225-1230.
Panchenko A, Przytycka T (2008) Protein-protein interactions and networks: identification, computer analysis, and prediction.

Klussmann E, Scott J, Aandahl EM (2008) Protein-protein interactions as new drug targets. Berlin: Springer.

e Kann MG (2007) Protein interactions and disease: computational approaches to uncover the etiology of diseases. Brief

Bioinform 8: 333-346.

e Shoemaker BA, Panchenko AR (2007) Deciphering protein-protein interactions. Part Il. Computational methods to predict
protein and domain interaction partners. PLoS Comput Biol 3: e43. doi:10.1371/journal.pcbi.0030043

Glossary

Mendelian traits or diseases, named after Gregor Mendel, are the traits inherited and controlled by a single gene.

Positional cloning is a method to find the gene producing a specific phenotype in an area of interest in the genome. The first
step of positional cloning is linkage analysis, in which the gene is mapped using a group of DNA polymorphisms from families

segregating the disease phenotype.

Epistasis refers to the phenomenon in which one gene masks the phenotypic effect of another.

Angiogenesis is the physiological process leading to growth of new blood vessels. Angiogenesis is a normal and vital process
in growth, development, and wound healing; but it is also a fundamental step in the transition of tumors from a dormant to a

malignant state.

Hemangioblastomas are tumors of the central nervous system that originate from the vascular system.
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